ADMS-Urban & ADMS-Roads

ArcGIS Link

User Guide

CERC
CONTENTS

SECTION 1 Getting Started ........................................... 1
SECTION 2 An introduction to ArcMap projects .............. 3
SECTION 3 Setting up an ADMS run using ArcMap .......... 6
  3.1 Overview .............................................................. 6
  3.2 Displaying existing sources and receptors ................. 7
  3.3 Creating point sources ........................................... 7
  3.4 Creating road sources ............................................ 8
  3.5 Creating area sources ............................................ 8
  3.6 Creating aircraft sources (ADMS-Airport only) .......... 8
  3.7 Creating line sources ............................................ 9
  3.8 Creating volume sources ....................................... 10
  3.9 Creating grid sources .......................................... 10
  3.10 Defining an output grid ....................................... 10
  3.11 Adding receptors ................................................ 11
  3.12 Completing the input file ...................................... 11
  3.13 Changing the symbology ...................................... 11
  3.14 Saving your project ............................................ 12
  3.15 Save Shapefile with Aliases .................................. 13
SECTION 4 Displaying ADMS results in ArcMap .............. 14
  4.1 Producing contour plots from ADMS results .......... 14
  4.2 Generating Transparent Filled Contours and Iso-Concentration Contours .............. 16
  4.3 Spatial Analyst settings used by the ADMS link ........ 18
  4.4 Reclassify the Concentration Layer ....................... 18
SECTION 5 Displaying Maximum Concentration Values .... 20
  5.1 Importing ADMS Output Files ............................... 20
  5.2 Clipping Points by Boundary ................................ 20
  5.3 Displaying Maximum Concentration Values ........... 21
SECTION 6 Emissions Inventory .................................... 23
  6.1 Step F – Transferring data from the ADMS Emissions Inventory to ArcMap ........... 25
  6.1.1 Adding the ADMS Emissions Inventory toolbar in to ArcMap ....................... 25
  6.1.2 Displaying sources from the ADMS Emissions Inventory ......................... 26
  6.1.3 Changing the ADMS Emissions Inventory ............................................. 28
  6.1.4 Other tasks available from the ADMS Emissions Inventory toolbar ........... 28
  6.2 Step G – Importing Raw Source and Emissions Data into ArcMap .................. 28
  6.3 Step H – Creating a grid source in ArcMap and exporting it to an ADMS Emissions Inventory ............................................................... 30
  6.4 Step I – Exporting selected point, road, area and grid source cells ................ 35
  6.5 Saving your project ............................................ 38
SECTION 7 Making a hard copy .................................... 39
  7.1 Creating a layout ................................................ 40
  7.2 Saving a template for future use ............................ 42
  7.3 Printing a layout ................................................ 42
  7.4 Saving a layout for a report .................................. 42
SECTION 8 Georeferencing images ............................... 43
8.1 Set map coordinates using a *.tfw World file ............................................................ 43
8.2 Set map coordinates using the georeferencing toolbar.............................................. 44
SECTION 1 Getting Started

In this document ADMS is used to refer to ADMS-Urban, ADMS-Roads, ADMS-EIA and ADMS-Airport.

In order to use the ADMS-Urban ArcGIS Extension you will need ADMS, ArcMap\(^1\) and Spatial Analyst. If you have not already done so, you should install them following the instructions provided with each product. Ensure the Spatial Analyst extension is switched on in ArcMap by launching ArcMap, selecting **Customize, Extensions...** and ticking Spatial Analyst.

To install the ADMS ArcGIS Link, log on as administrator, locate your ADMS application directory, e.g. `C:\Program Files\CERC\ADMS`, select the folder `Support\ArcGIS` and double click on `Setup.exe`. This will take you through the install wizard and install the links.

To use the ADMS ArcGIS link you should:

**Step 1**  Launch ArcMap by double-clicking on the ArcMap icon.

**Step 2**  Then right click anywhere on the tool bar for a list of the available toolbars. See Figure 1.1.

![Figure 1.1 – List of ArcMap toolbars.](image)

**Step 3**  Click the **ADMS-Urban** tool and the toolbar will be added to the view.

---

\(^1\) Check [cerc.co.uk](http://cerc.co.uk) for any updates to the list of supported ArcGIS versions.
If ADMS is not in the list then select **Customize**... at the bottom of the list (Figure 1.2). Then select the **Add from file**... button. This will launch a browser dialogue; locate the file `ADMS_URBAN_ArcGISLink.dll`, this should be in your ADMS ArcGIS application directory `C:\Program Files\CERC\ADMS-ArcGIS\ADMS`. You will be shown a message, click **OK** to this, then tick the **ADMS-Urban** toolbar as shown in Figure 1.3. Finally click **Close** and the toolbar will be added to ArcMap.

You are now ready to use ADMS with ArcGIS.

---

**Figure 1.2** – List of ArcMap toolbars.

**Figure 1.3** – The ArcMap toolbar Customization screen.
SECTION 2 An introduction to ArcMap projects

This section provides a brief introduction to the use of ArcMap so before using the ADMS ArcGIS tools, it is recommended that the user completes the ArcMap tutorial supplied with the software in order to become accustomed to ArcMap terminology.

ArcMap has two modes of working: data view and layout view. The latter is used for producing layouts for reports and is described in Section 7. In order to use the full capabilities of the ADMS link, the user must be working in data view, which is the default view when ArcMap opens. If you are not in the data view you can switch to data view by selecting the globe button shown at the bottom of the screen in Figure 2.1.

![Figure 2.1 – The data view in the ArcMap Project screen.](image)

ArcMap work is saved in ArcMap Documents (.mxd files). Figure 2.1 shows a Document Window within the ArcMap interface which at present is untitled. To give the project a title click on File, Save As... and choose a directory and title for the project.

Map data is entered into Layers. These layers are stored in Data Frames which can be seen in the Table of Contents, as shown in Figure 2.2 (currently your ArcMap document will not contain any layers).
To load an OS map as a layer click on the **File** menu and, via the **Add Data** submenu, select the **Add Data**... button or select the **Add Data** button from the toolbar. Figure 2.3 shows the **Add Data** dialogue that is launched.

Locate the data you want to add as a new layer and select the **Add** button.

You may see a message similar to that shown in Figure 2.4 if the spatial reference has not been set; in this case just click **OK**.
SECTION 2 – An introduction to ArcMap

Figure 2.4 – Error message if a Spatial Reference has not been set for the map.

The title of the layer is added to the data frame. Click on the tick box next to the layer title to switch the view of the layer off and on as shown in Figure 2.5.

Figure 2.5 – An example of an OS data tile loaded into ArcMap.

In ArcMap if you have no associated .tfw file with your .tif file, then the map data may not be positioned at the correct location on your map. Data tends to be supplied in decimal degrees so that it can be easily transformed into other coordinate systems. To position the tile with the correct National Grid coordinates, it is necessary to initially set the coordinate system: refer to Section 8 for further details on how to do this.

You are now ready to position sources on the map and set up an ADMS run.
SECTION 3 Setting up an ADMS run using ArcMap

3.1 Overview

Once your map image is registered, you are ready to position sources on the map and set up an ADMS run.

The ADMS ArcGIS extension is controlled from buttons on the toolbar. The toolbar is shown in Figure 3.1, and the buttons are described in Table 3.1.

![Figure 3.1 – The ADMS toolbar.](image)

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show ADMS" /></td>
<td>Show ADMS</td>
<td>Activates the ADMS interface</td>
</tr>
<tr>
<td><img src="image" alt="Refresh All Data" /></td>
<td>Refresh All Data</td>
<td>Updates the ArcMap display with all the sources in the current .apl file</td>
</tr>
<tr>
<td><img src="image" alt="Add Airport Source" /></td>
<td>Add Airport Source</td>
<td>Adds a new ADMS-Airport aircraft source at a location specified by clicking in the data view window (double-click to end the aircraft source). Only available with ADMS-Airport.</td>
</tr>
<tr>
<td><img src="image" alt="Add Point Source" /></td>
<td>Add Point Source</td>
<td>Adds a new ADMS point source at a location specified by clicking in the data view window.</td>
</tr>
<tr>
<td><img src="image" alt="Add Road Source" /></td>
<td>Add Road Source</td>
<td>Adds a new road source at a location specified by clicking in the data view window (double-click to end the road source)</td>
</tr>
<tr>
<td><img src="image" alt="Add Area Source" /></td>
<td>Add Area Source</td>
<td>Adds a new ADMS area source at a location specified by clicking in the data view window (double-click to end the area source)</td>
</tr>
<tr>
<td><img src="image" alt="Add Line Source" /></td>
<td>Add Line Source</td>
<td>Adds a new line source at a location specified by clicking in the data view window (double-click to end the line source)</td>
</tr>
<tr>
<td><img src="image" alt="Add Volume Source" /></td>
<td>Add Volume Source</td>
<td>Adds a new volume source at a location specified by clicking in the data view window (double-click to end the volume source)</td>
</tr>
<tr>
<td><img src="image" alt="Add Receptor" /></td>
<td>Add Receptor</td>
<td>Adds a new receptor point for generating output concentrations</td>
</tr>
<tr>
<td><img src="image" alt="Define Contour Area" /></td>
<td>Define Contour Area</td>
<td>Defines an ADMS output grid over the rectangle drawn</td>
</tr>
<tr>
<td><img src="image" alt="Generate Contours" /></td>
<td>Generate Contours</td>
<td>Creates a contour layer of concentrations based on ADMS output and adds it to the View</td>
</tr>
<tr>
<td><img src="image" alt="Import ADMS Output" /></td>
<td>Import ADMS Output</td>
<td>Imports an ADMS output file into ArcMap</td>
</tr>
<tr>
<td><img src="image" alt="Clip Point To Boundary" /></td>
<td>Clip Point To Boundary</td>
<td>Clips a point layer according to the boundaries in a polygon layer</td>
</tr>
</tbody>
</table>
### 3.2 Displaying existing sources and receptors

ArcMap will display the locations of any sources and specified receptor points that are included in the ADMS input file (.upl). A separate layer will be added for each source type. Point, line, area, volume, road and aircraft sources are displayed along with specified receptor points. Buildings are not displayed and cannot be created or edited using the ADMS-ArcGIS link.

If you already have an existing ADMS input file, then click on the **Refresh** button ![refresh_icon] to display all the sources in the file, and any specified receptor points.

If you wish to add a new source(s), follow the appropriate instructions in sections 3.3 to 3.11.

### 3.3 Creating point sources

Follow the steps below to create a point source from within ArcMap.

1. **Step 1** Click the **Add Point Source** button ![add_point_icon]
2. **Step 2** Click on the map window at the location you want to position your point source.
3. **Step 3** A new point source is created and displayed in the ADMS **Source** screen. The source co-ordinates will have been filled in automatically, but you will need to enter the other parameters for the source. Refer to the ADMS User Guide for further details.
4. **Step 4** To add another point source, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.
5. **Step 5** The location of the point source(s) should automatically be added to the map. If for any reason they are not then click the refresh button ![refresh_icon]
3.4 Creating road sources

Follow the steps below to create a road source from within ArcMap.

**Step 1**  Click the **Add Road** button.

**Step 2**  Click on the map at the starting point of your road. Then draw the road on the map, clicking once for each vertex. Double-click at the final vertex.  

*Hold down the right mouse button and move the cursor around the map to pan while drawing.*

**Step 3**  A new road source is created and displayed in the ADMS **Source** screen. The source co-ordinates will have been filled in automatically, but you will need to enter the other parameters for the source. Refer to the ADMS User Guide for further details e.g. for advice about road widths and canyon heights.

**Step 4**  To add another road source, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.

**Step 5**  The location of the road source(s) should automatically be added to the map. If for any reason they are not then click the refresh button.

3.5 Creating area sources

Follow the steps below to create an area source from within ArcMap.

**Step 1**  Click the **Add Area** button.

**Step 2**  Click on the map at the position of one of the vertices. Then, moving around the source clockwise or anticlockwise, click at the position of the remaining vertices, double-clicking at the final vertex. An area source can have three to fifty vertices.

*Hold down the right mouse button and move the cursor around the map to pan while drawing.*

**Step 3**  A new area source is created and displayed in the ADMS **Source** screen. The source co-ordinates will have been filled in automatically, but you will need to enter the other parameters for the source. Refer to the ADMS User Guide for further details.

**Step 4**  To add another area source, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.

**Step 5**  The location of the area source(s) should automatically be added to the map. If for any reason they are not then click the refresh button.

3.6 Creating aircraft sources (ADMS-Airport only)

Follow the steps below to create an area source from within ArcMap.
**Step 1**  Click the **Add Aircraft** Source button.

**Step 2**  An aircraft source must be a simple straight line with only two vertices. Click on the map at the position for one end of the source. Then, double-click the mouse button to position the other end.

**Step 3**  You will be prompted for the name of the new aircraft source (see below).

![New aircraft source dialog](image)

**Step 4**  A new line will automatically be written to the end of the `.air` file. The Src_Name, X0, Y0, X1, and Y1 columns will be filled in. The other columns are set to default values (-999). You must edit the `.air` file manually and fill in these columns with valid entries. Refer to the ADMS-Airport User Guide for further details. You can open the `.air` file for editing by clicking the **Edit** button in the ADMS-Airport interface.

**Step 5**  To add another aircraft source, return to ArcMap by clicking on the ArcMap window title bar, and repeat the steps.

**Step 6**  Click the refresh button ![refresh button](image) to show the location of the new aircraft source(s) in ArcMap.

### 3.7 Creating line sources

Follow the steps below to create a line source from within ArcMap.

**Step 1**  Click the **Add Line** Source button.

**Step 2**  Click on the map at the position of one end of the source. Then draw the line on the map, clicking once for each vertex. Double-click at the final vertex.

*Hold down the right mouse button and move the cursor around the map to pan while drawing.*

**Step 3**  A new line source is created and displayed in the ADMS **Source** screen. The source co-ordinates will have been filled in automatically, but you will need to enter the other parameters for the source. Refer to the ADMS User Guide for further details.

**Step 4**  To add another line source, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.

**Step 5**  The location of the line source(s) should automatically be added to the map. If for any reason they are not then click the refresh button ![refresh button](image).
3.8 Creating volume sources

Follow the steps below to create a volume source within ArcMap.

**Step 1** Click the Add Volume Source button.

**Step 2** Click on the map at the position of one of the vertices. Then, moving around the source clockwise or anticlockwise, click at the position of the remaining vertices, double-clicking at the final vertex. A volume source can have three to fifty vertices.

*Hold down the right mouse button and move the cursor around the map to pan while drawing.*

**Step 3** A new volume source is created and displayed in the ADMS Source screen. The source co-ordinates will have been filled in automatically, but you will need to enter the other parameters for the source. Refer to the ADMS User Guide for further details.

**Step 4** To add another volume source, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.

**Step 5** The location of the new source(s) should automatically be added to the map. If for any reason they are not then click the refresh button.

3.9 Creating grid sources

Grid sources must be added directly in the ADMS interface as described in the ADMS User Guide. You will be able to see the location of these by clicking the refresh button.

3.10 Defining an output grid

Follow the instructions below to define an output grid within ArcMap.

**Step 1** Click on the Define Contour Area button.

**Step 2** Click on the map at one of the corners of the output grid area and, while holding down the mouse button, drag the mouse to the opposite corner of the area. Now drag the mouse to the opposite corner of the area. A rectangle will appear on the map while you drag the mouse. When the rectangle reaches the size you require release the mouse button.

**Step 3** You are then asked “Do you wish to use this area for the ADMS output grid?” If the correct area has been selected then click Yes. Otherwise, click No and select a new output grid. Click Yes when you have selected a suitable area.

**Step 4** The ADMS Grids screen will appear with the new output grid coordinates. You may modify the coordinates by hand if you wish.
3.11 Adding receptors

Follow the steps below to define receptors (also known as “specified points”) using ArcMap.

Step 1 Click the Add Receptor button.

Step 2 Click on the map at the position for the new receptor point.

Step 3 The ADMS Grids screen appears, showing your new specified point with the coordinates of the point at which you clicked. You should provide a name for the point.

Step 4 To add another receptor, return to ArcMap by clicking on the ArcMap window title bar, and repeat steps 2 and 3.

Step 5 The location of the receptor source(s) should automatically be added to the map. If for any reason they are not then click the refresh button.

3.12 Completing the input file

Complete the rest of the ADMS model set-up (met data, pollutant data, emission rates etc.) in the ADMS interface. Refer to the ADMS user guide for further details.

Save and run the ADMS model as normal.

You are now ready to display your ADMS results in ArcMap.

3.13 Changing the symbology

The appearance of the ADMS layers can be changed either by right clicking on the layer and selecting the properties button, or by double clicking on the layer. This opens the Layer Properties screen. Select the Symbology tab as shown in Figure 3.2.
SECTION 3 – Setting up an ADMS run using ArcMap

Figure 3.2 – The symbology tab of the Layer Properties screen.

You can change the colour and style by clicking the box in the Symbol frame and choosing a new colour. Once you are happy with the appearance click OK to return to the map, or click Cancel to discard any changes and return to the map.

To save your chosen colours and styles click the Save Current Symbology as Default button. The default colours and styles will have been overwritten. From now on the ADMS layers will appear in the new colours and styles in all your ArcGIS projects.

3.14 Saving your project

If ArcMap contains any ADMS layers when you close the project you will be asked whether you want to save the ADMS shapefiles under a different name so that they are not deleted, as shown in Figure 3.3.

Figure 3.3 – Closing project warning message.

If you click No, the project will close and none of the ADMS shapefiles will be saved. If you click Yes then you will be returned to your project where you can save the files.

The ADMS shapefiles are deleted each time ArcMap is closed because they contain the data that is currently loaded in the ADMS user interface. These files therefore frequently change and do not remain fixed for a given project. If you want to view sources from a particular
.upl file you must either have it loaded in the interface, or you must permanently save the sources to a shapefile so they can be viewed without using the ADMS link. This can be useful when creating layouts for a report.

If you want to save the shapefiles, use the **Save Shapefile with Aliases** button which is described in Section 3.15. You will have to repeat this for each of the layers. You can now remove the ADMS layers from the project and save it. When you close the project you will no longer see any warnings.

Remember that the saved files will contain a ‘snapshot’ of the data loaded in the ADMS user interface at the time that they were saved; if you change the .upl file you may want to resave the shapefiles.

### 3.15 Save Shapefile with Aliases

This command saves a shapefile and associated layer file in the same location, for the selected layer. This ensures any column aliases are saved with the data. This command should be used to make a copy of the source data being displayed by the ADMS – ArcGIS link, rather than the ArcGIS **Export Map** menu option, as the **Export Map** menu option will not retain pollutant names or other column aliases.

**Step 1**  Click on the **Save Shapefile with Aliases** button to display the save dialogue.

**Step 2**  Specify the location and the name of the exported shapefile and layer file (they will be saved with the same name but different file extensions).

**Step 3**  Click on **Save**.
SECTION 4  Displaying ADMS results in ArcMap

4.1 Producing contour plots from ADMS results

Once you have completed your ADMS input file (.upl) and run the model, you can display the results by creating contour plots in ArcMap. Please note that you must have used gridded output to create a contour plot. On the Grids screen the Select output option must be either Gridded or Both.

Follow the steps below to produce a contour plot.

**Step 1**  In the ArcMap interface, press the Generate Contours button.

**Step 2**  The ADMS Contour Plotter screen will appear, as shown in Figure 4.1.

![Image of ADMS Contour Plotter](image.png)

*Figure 4.1 – The ADMS Contour Plotter.*

**Step 3**  Select the correct output file and click on Plot.

*Check that you have the correct pathname and that you have selected short term or long term results as required.*

**Step 4**  The Save Output Raster dialogue box then appears as shown in Figure 4.2. Select the location in which to save the file, edit the filename if required, and then click Save. This will save the concentration contours in an output raster file which can be saved as part of the ArcMap document file (*.mxd).*
Step 5

The contours will then be added to the view overlaying the map as shown in Figure 4.3. Section 4.2 describes how to make the concentration contours transparent so that you can see the underlying map information.

Figure 4.2 – Save Output Raster screen

Figure 4.3 – Example concentration contours plotted using Spatial Analyst.
4.2 Generating Transparent Filled Contours and Iso-Concentration Contours

Use the following instructions to increase the transparency of the contour layers so that the background map and ADMS sources and receptors are visible beneath them.

**Step 1**
Double click on the concentration layer to view the Layer Properties screen, or right click on the layer and select the Properties... button. (Figure 4.4 shows the Layer Properties screen for the NOx_µg_m³ layer of Figure 4.3)

**Step 2**
Select the Symbology tab. Double click on the dark blue colour for the lowest range, then select the No Color option and click OK. This means that you are able to see a lot more of the map where the values were either zero or very low.

**Step 3**
Select the concentration layer in the Effects Layer then select the Adjust Transparency button, slide this up to about 25%. This makes the contour layer more transparent so that you can see the data underneath, as shown in Figure 4.5

![Figure 4.4 – The Symbology tab of the Layer Properties screen.](image-url)
 SECTION 4 – Displaying ADMS results in ArcMap

Figure 4.5 – The map with overlaid shaded contours.

It is also possible to view iso-concentration contour lines (e.g. to show the contour for a specific concentration), as shown in Figure 4.6. To do so, ensure the Spatial Analyst tool bar is open by right clicking on the main toolbar and selecting Spatial Analyst. Make sure the Spatial Analyst layer selected is the appropriate concentration layer, e.g. NOx$_{\mu g\,m^3}$. Click on the create contour tool, then click anywhere on the grid and a contour will be produced that matches the concentration at that location. Alternatively, you can select the Spatial Analyst drop down menu and select Surface Analysis and Contour.... The contour screen appears; this allows you to enter any number of contours required and the interval at which you would like them displayed.
4.3 Spatial Analyst settings used by the ADMS link

The ADMS link uses ESRI Spatial Analyst to interpolate the concentration data. It is recommended that the user allow this to be done automatically. The concentration data is interpolated using the gridding method known as inverse distance weighting.

However, the details of the interpolation process can be selected manually if the user wishes. For full details refer to the ESRI Spatial Analyst help.

4.4 Reclassify the Concentration Layer

You might want to reclassify the concentration layer grid so that you can compare different files on the same scale. This can be done by double clicking on the concentration layer to view the Layer Properties screen, or right clicking on the layer and selecting the Properties... button as shown in Figure 4.4.

On the Symbology tab of the Layer Properties screen you can select the Classify... button (Figure 4.4) and change the number of breaks, limits and colours in the Classification screen shown in Figure 4.7.
Figure 4.7 – The Classification screen.
SECTION 5  Displaying Maximum Concentration Values

The ADMS Link provides the facility to calculate the maximum concentration values in an ADMS output file outside, or inside, a site boundary. Typically you would run the following three options in order: import an ADMS output file following the instructions in Section 5.1; delete unwanted points by following the instructions in Section 5.2, and finally display the maximum concentration values of the remaining points following the instructions in Section 5.3.

5.1 Importing ADMS Output Files

ADMS output files (.glt, .gst, .plt, .pst) need to be converted into a point shapefile in order to be used or viewed within ArcMap. The attributes of the points provide the ADMS output values for that point, and the coordinates.

Step 1  Click on the Import ADMS Output button to display the Import ADMS Output screen, as shown in Figure 5.1.

![Import ADMS Output Screen](image)

Figure 5.1  – The Import ADMS Output screen

Step 2  Use the top browse button to locate the ADMS output file to import.

Step 3  Use the second browse button to define the output shapefile’s location and filename, or accept the default.

Step 4  Click OK

5.2 Clipping Points by Boundary

The Clip Point by Boundary button deletes points from a point shapefile. The points are compared against a set of polygons in a boundary shapefile and excluded depending on whether you wish to keep points inside or outside the boundary. ADMS area or volume source layers can be used as boundary shapefiles.

Step 1  Ensure the point and boundary shapefiles are open in ArcMap.
**Step 2**  Click on the **Clip Point by Boundary** button to display the **Clip Points by Boundary** screen, as shown in Figure 5.2.

![Figure 5.2 – The Clip Points by Boundary screen.](image)

**Step 3**  Select the layer containing the constraining polygons from the **Boundary Layer** list.

**Step 4**  Select the layer containing the ADMS point data from the **Point Layer** list.

**Step 5**  Choose whether to keep only the points within the boundaries, or only the points outside the boundaries.

**Step 6**  Click **OK**.

---

### 5.3 Displaying Maximum Concentration Values

The maximum value for each category (e.g. short-term NO\textsubscript{X} concentration) within a point shapefile and the coordinates of the points at which these maximum values occur can be displayed. To do this, follow the instructions below.

**Step 1**  Click on the **Report Max Values** button to display the **Display Max Values** list, as shown in Figure 5.3.

**Step 2**  Select the point layer in the dropdown to display a list containing the maximum values for each concentration recorded in the shapefile.

The information in the list is also automatically copied, ready to paste into another program, e.g. Microsoft Word.

![Figure 5.3 – The Display Max Values screen.](image)
Step 3  Click a row’s **Highlight** button to highlight that row’s maximum value point(s) on the map.

Step 4  Click **OK** to close the screen
SECTION 6  Emissions Inventory

Sections 3 and 4 of the ADMS User Guide describe how to set up ADMS model runs by typing data into boxes in the interface when there is a small amount of source data involved. However, ADMS users will typically have a large volume of data; for instance, if they have compiled their own emissions inventory. In that case, rather than typing data into the interface, the tools described in this section can be used to set up model runs and manipulate the data. These tools use the ADMS Emissions Inventory, which is a Microsoft Access database with a format such that the data can be directly imported into ADMS.

The available routes for getting from the raw emissions data to an ADMS .upl file are illustrated in Figure 6.2. The route from raw data to a .upl file followed by most users is via Steps A, B, C and E. The route shown by I is for grid (aggregated) sources only, although in Step G point, road or grid sources may be imported and then aggregated. The route shown by step J makes use of the Extract Sources From CSV File... utility which provides an alternative method for importing sources.

Steps A, B, C, D and E are described in Section 7 of the ADMS User Guide. Details of steps F, G, H and I are given below. Step J is described in Section 6.6 of the ADMS User Guide.

Another piece of CERC software, EMIT, an EMissions Inventory Toolkit, is a convenient, alternative way to prepare data corresponding to Steps A to B. Further information about EMIT can be found at www.cerc.co.uk/environmental-software/EMIT-tool.html.

Selecting an ADMS Emissions Inventory file

You will probably want to work with several different inventories; for example, each inventory may contain data for a different year or a different emissions-management scenario. You can create or change inventory files via the ADMS-Urban interface. In ADMS-Urban, select the File, Preferences, Inventory Database menu. This will open the screen shown in Figure 7.1 below. In order to:

* create a new inventory, click New.
* change inventory, click Browse.
Figure 6.2 – The steps involved in manipulating raw source and emissions data into an ADMS-Urban .upl file. Note that Step I applies to grid sources only. (Grid sources are not available with ADMS-Roads.)
In the remainder of this section, details of steps F, G, H and I for manipulating source and emissions data depicted in Figure 6.2 are given.

### 6.1 Step F – Transferring data from the ADMS Emissions Inventory to ArcMap

Once you have loaded your data into the Access emissions inventory, it can be transferred into ArcMap. This can be useful; for example, to check whether sources have been correctly located.

You will first need to add the Emissions Inventory toolbar into ArcMap. Section 6.1.1 describes how to do this. Section 6.1.2 then shows how to display the sources; Section 6.1.3 gives instructions for changing to a different database; and Section 6.1.4 outlines some of the other tasks available with the Emissions Inventory toolbar.

#### 6.1.1 Adding the ADMS Emissions Inventory toolbar in to ArcMap

To use ArcMap and ADMS in conjunction with the Inventory, start up ArcMap. Right click anywhere on the toolbar for a list of the available tools; see Figure 1.1. Click the Emissions Inventory tool and the toolbar will be added to the view, as shown in Figure 6.3. You are now ready to use ADMS with ArcGIS.

![Emissions Inventory toolbar](image)

Figure 6.3 – The Emissions Inventory toolbar.

If Emissions Inventory is not in the list then select Customize... at the bottom of the list as shown in Figure 1.2. Then select the Add from file... button. This will launch a browser dialogue; locate the file Emissions_Inventory_ArcGISLink.dll, this should be in your ADMS ArcGIS application directory \C:\Program Files\CERC\ADMS-ArcGIS\EI. You will be shown a message, Click OK to this, then tick the Emissions Inventory toolbar. Finally click Close and the toolbar will be added to ArcMap.

Before continuing to use the emissions inventory toolbar, it is helpful to customise it so that it will display the name of any selected emissions inventory database. To do so, right click anywhere on the ArcMap toolbar and select the Customize...button at the bottom of the list. Then right click the Change emissions inventory button shown in Figure 6.4, this will bring up a menu. Select Image and Text, this will then display the tool bar as shown in Figure 6.5. Select Close on the Customize window. Once an inventory has been chosen, you will be able to see the name of the database on the toolbar.
6.1.2 Displaying sources from the ADMS Emissions Inventory

To display the emissions inventory sources in ArcMap, you first need to select an emissions inventory. Select the Change emissions inventory button, this will launch a browse dialogue, select the inventory you want to display and press Open.
The data will automatically be displayed as shown in Figure 6.7 to show the locations of all sources held in the emissions database.

To view the data in the emissions inventory in the form of a table, right click on the **El Road Source** layer and select **Open Attribute Table**. ArcMap will open a table showing the emissions of all pollutants from each source.
6.1.3 Changing the ADMS Emissions Inventory

To change to a different emissions inventory database, choose the Change emissions inventory button and browse for a new database. ArcMap will automatically update the display to show the locations of all sources held in the new emissions database.

6.1.4 Other tasks available from the ADMS Emissions Inventory toolbar

As well as displaying the data from the emissions inventory, the ArcMap Emissions Inventory link can be used to create a grid source by aggregating other sources, and then to export the grid source to the ADMS interface for modelling. These options are described in Sections 6.3 and 6.4.

The ADMS ArcMap Emissions Inventory link can also be used to select sources, for instance those emitting above a certain threshold or those belonging to a certain plant operator, and export the sources to ADMS. This is described in Section 6.4.

6.2 Step G – Importing Raw Source and Emissions Data into ArcMap

It is possible to transfer raw source and emissions data for industrial sources directly into ArcMap (Step G). These data cannot be exported as individual sources to the ADMS emissions inventory or the ADMS interface. However, the sources can be aggregated into a grid source in ArcMap, see Section 6.3. This grid source can then be exported to the emissions inventory and hence to the ADMS interface. This example shows how data for four industrial stacks can be imported to ArcMap.

If the point source data are held in an Excel file, you should save these data as a .csv, .xls or .xlsx file in order to import it into ArcMap. To save the data as an .xlsx file, select all cells...
containing data as shown in Figure 6.9. In Excel select **File, Save As** and save the data as an Excel workbook. This `.xls` or `.xlsx` file can now be read into ArcMap as a table. Road or grid source data are likely to be available as an ArcMap `.shp` file, in which case the data can be loaded directly into ArcMap.

Launch ArcMap and open an existing workspace; for example, one containing a map tile on which to plot the source locations.

**Figure 6.9** – Selecting data in Excel for saving as an `.xls` or `.xlsx` file.

**Figure 6.10** – Display XY Data wizard.

Select the **Add Data** button ![Add Data](Image), or select the **Add Data**... option from the **Add Data** submenu in the **File** menu. Browse for the file that you created and click **Add**. You will then be
prompted to select the worksheet containing the data. Once this has been selected, the data will be added to ArcMap in the form of a table and you will see it under the Layers heading in the table of contents. Right click on the layer and select Display XY Data..., this opens a wizard, see Figure 6.10. The X and Y fields should have been automatically detected, but if the wrong fields were selected, change them to the correct fields and click OK.

The data will have now been added to the display, see Figure 6.11. The data has been added as a new layer because a temporary shape file has been created. To make the points stand out more against the background, double click the points Events layer and select the symbology tab, change the colour and size of the points and click OK.

6.3 Step H – Creating a grid source in ArcMap and exporting it to an ADMS Emissions Inventory

Grid sources are not available in ADMS-Roads. ADMS-Roads users should skip this section.

How to create a grid source in ArcMap and export it to an emissions inventory

The ArcMap Emissions Inventory extension contains a useful tool for creating a grid source of total emissions from explicit sources that you have in an existing emissions inventory. This grid source can then be exported to an emissions inventory database.

Step 1 In ArcMap, ensure that the ADMS Emissions Inventory toolbar is open, and select the emissions inventory database containing the source emissions data that you want to aggregate into a grid source.

Step 2 Move the cursor over your data and make a note of the coordinates and extent of the grid source required to cover all your source data.
Step 3  In the case shown above, it turns out that the southwest corner of the grid source should be (544000,158000) and the grid should extend 2km east-west and 2km north-south.  

_In ADMS the extent of the grid source must be less than 60km from east to west and 60km from north to south._

Step 4  Select the first layer that you want to aggregate to a grid. If you are going to aggregate several layers to the same grid then this should be the layer that covers the largest area. In the example above we select the EI Roads Source layer. Then select the **Aggregate To Grids** button which should now be enabled. The **Select Emission Columns** screen opens Figure 6.13.

Step 5  The link will try to detect which columns contain emissions, you should check these and select any that were not detected or deselect any that are incorrect. You
also need to select the correct units for the emissions from the drop down box, in this case \( g/km/s \), then select **OK**.

**Step 6** If the units selected were \( g/m^3/s \) or \( g \cdot m^3 \cdot s \) the screen shown in Figure 6.14 will appear and you have to select the depth column. The link will automatically select the first field that begins ‘depth’. Click **OK** to move to the next screen.

![Figure 6.14 – The Select Depth Column screen.](image)

**Step 7** The **Select a grid shape file** window now opens, as shown in Figure 6.15. You can either add the emissions to an existing grid or create a new one. In this case select the **New...** button to create a new grid.

![Figure 6.15 – Select a grid shape file.](image)

**Step 8** The **Create Grid** dialogue box now opens Figure 6.16. The grid extent is calculated based on the size of the layer. You should check this is large enough for all the sources. Once a grid has been created it cannot be made larger though the wizard. Press the **Browse...** button and select a location for the output file. If you are happy with the cell size and number of cells select **OK**, otherwise change them.
**Step 6**

A check is carried out to see if you have NO\textsubscript{X} and NO\textsubscript{2} selected. If you have selected just one you will receive a warning message.

If the source contains zero or blank values for NO\textsubscript{X} emissions but nonzero NO\textsubscript{2} values then the aggregation will assume that all NO\textsubscript{X} is emitted as NO\textsubscript{2} and the dialogue box shown in Figure 6.17 will appear; click **Yes**.

On the other hand, if the source contains NO\textsubscript{X} emissions but no NO\textsubscript{2} emissions you will be asked to specify the percentage of NO\textsubscript{X} that is emitted as NO\textsubscript{2}. The format of the dialogue box that appears depends on the type of source that is being aggregated to the grid. Figure 6.18 shows the format of the dialogue box for road sources. The format is the same for industrial sources except that the initial value shown for the percentage of NO\textsubscript{2} is 5%.

Specify the percentage of the NO\textsubscript{X} that is NO\textsubscript{2}, or alternatively use the default value provided. Then click **OK**.

---

**Figure 6.16** – Create Grid dialogue box.

**Figure 6.17** – Aggregation warning.

**Figure 6.18** – Specifying percentage NO\textsubscript{X} as NO\textsubscript{2}.
Section 6 – Emissions Inventory

See Appendix B of the ADMS User Guide for further information on the assumptions ADMS uses when modelling NO\textsubscript{X} and NO\textsubscript{2}.

**Step 7** ArcMap will then create the grid source, if necessary, and add the aggregated emissions from the source table you have selected. The new grid source will automatically be displayed in the current map window.

**Step 8** Repeat the steps from Step 3 to Step 7 for each source layer that you wish to aggregate into the grid source.

**Step 9** The grid source you have created is now ready to export to the emissions inventory, as described below.

**Exporting a grid source**

If you have created a grid source as described in Step H, Section 6.3, or displayed a grid source from an existing emissions inventory as described in Step F, Section 6.1. Select the grid layer, then select the **Export Grids to Emissions Inventory** button. This will open the Select Emission Columns dialogue box Figure 6.19.

![Select Emission Columns](image)

**Figure 6.19** – Select Emission Columns for exporting.

**Step 9** Select the fields that contain the emissions and the appropriate units from the drop down, then select **OK**.

**Step 10** Another dialogue is opened as in Figure 6.20. Use this dialogue to select a pollutant for each emissions field. To assist with this, default selections are made automatically based on the emissions field names, but you should check that the correct pollutant has been chosen in each case. Also note that in the example shown, the NO\textsubscript{2} emissions have been created during aggregation, with emission levels calculated from the NO\textsubscript{X} emissions.
Step 10  Adjust the selection if necessary by choosing different pollutants from the drop-down lists. The available list of pollutants is based on the list of pollutants defined in the Pollutants Palette in the ADMS interface. If you wish to use a non-standard pollutant, you must explicitly define it in the ADMS interface Pollutant Palette before attempting to export the emissions from ArcMap. When you are satisfied that the correct ADMS pollutant is chosen from the drop-down list for each emission heading, press **OK**.

![Choose Pollutants For The Emissions](attachment:image.png)

**Figure 6.20** – Select the pollutants screen.

Step 11  Finally, choose the grid source depth that you require, and press **OK** to complete the export process. The default grid source depth is 10 metres.

Your grid source will be exported to the emissions inventory. Data for any grid source cells that already exist in the emissions inventory will not be over-written. A warning message is shown to the user if grid source cells already exist in the emissions inventory.

![Enter Grid Depth](attachment:image.png)

**Figure 6.21** – Grid Depth dialogue.

6.4  **Step I – Exporting selected point, road, area and grid source cells**

ArcMap can be used to export selected emissions inventory sources, for instance those emitting above a certain threshold or those from a certain plant operator or lying within a certain area, to ADMS for modelling.

Ensure the data you want to select is visible. Select **Selection, Select By Location...** from the menu to open the dialogue shown in Figure 6.22.
Select the **El Road Source** and then click **Close**. Use the **Select Feature Tool** to select the sources to be transferred from the emissions inventory to the ADMS Interface. Features can be selected in a variety of ways; for example, by drawing a rectangle around the desired features. You can choose whether to select only features completely enclosed by the rectangle or features partially enclosed by the rectangle etc. from the options in the **Selection, Selection Options...** menu.
Figure 6.23 – Selected features.

Figure 6.23 shows that only the road sources were selected.

Select the layer EI Road Source in ArcMap and click the Export Selected Sources to ADMS button. The screen shown in Figure 6.24 will be displayed, click Next >.

Figure 6.24 – The Import from Emissions Inventory (1: Pollutants) window.

The screen shown in Figure 6.25 is then displayed.

The sources that you have selected in ArcMap are shown in the Sources to import box on the left of the screen. Sources listed in this box will be imported into the ADMS interface; those shown in the box on the right hand side will not.
If you decide not to import some of your sources that you have selected in ArcMap, click on **Remove** to remove them from the **Sources to import** box. Alternatively, if you want to import sources from the emissions inventory that you have not already selected in ArcMap, these can be added to the **Sources to import** box by clicking on the **< Add** button. Click on **Finish** when you have made your selection.

![Image](image_url)  
**Figure 6.25** – The Import from Emissions Inventory (2:Sources) window.

### 6.5 Saving your project

If ArcMap contains any Emission Inventory layers when you close the project you will be prompted to save them under a different name so that they are not deleted. This behaves in the same way as the main ADMS link; please refer to Section 3.14 for a further explanation.
SECTION 7 Making a hard copy

There is a facility to make attractive layouts for reports in ArcMap. It is straightforward to create a default layout which can then be edited to your own particular taste. To make a layout of the current view, click on the menu **View**, then **Layout View**, or select the Layout View button at the bottom of the map, as shown in Figure 7.1.

The screen will change to the layout view with the current map framed and the Layout tool bar launched as shown in Figure 7.2. Instructions for creating a layout can be found in Section 7.1. Once you are happy with your layout, it can be printed (refer to Section 7.3 for further details) or saved as an image file (refer to Section 7.4 for further details). The printout and image file will appear exactly as seen in the layout view.

**ADMS buttons will appear grey when working in layout view, as the user must be in data view to use the full capabilities of the ADMS link described in Section 3 and Section 4.**

![Figure 7.1 – The Layout View button](image)

![Figure 7.2 – The layout view.](image)
7.1 Creating a layout

If you have any default layers defined you can select them by clicking the Change Layout button on the layout tool bar and following the wizard. Refer to Section 7.2 for further details. If you don’t have existing default layers you can create your own. This section provides an example.

Change the page layout by selecting the File menu, clicking Page and Print Setup..., and selecting the Orientation Landscape before clicking OK. Drag the edges of the frame so that they fit on the page. When you print it, the image will appear exactly as you see it on the layout view. Select the Insert menu button and click Legend…. Select the layers that you want in the legend and click Next, as shown in Figure 7.3. On the following screen you can alter the text and formatting of the legend title. Further properties of the legend can be altered in the following three screens. Drag the legend into a suitable position and resize if necessary.

![Legend Wizard](image)

*Figure 7.3 – The Legend Wizard screen.*

You can change the number of decimal places or significant figures in your legend if any layers are showing too many or too few. Double click on the layer to open the layer properties screen. Select the Symbology tab and click on the Label heading, then select Format Labels…. The Number Format screen opens as shown in Figure 7.4. Select Numeric and change the rounding to Number of decimal places, change the Rounding type and number of digits to the option you wish to display. Click OK on the Layer properties to close it and apply the changes to your legend.
Figure 7.4 – The Number Format screen.

To add a title, select **Insert** from the menu and click **Title**. Then type your title and press Return. To edit the properties of the title double click it. To change the font properties of the title, click on the **Change Symbol**... button, then choose the font and text size, style and colour. To change the background colour of the title, select **Properties** and click the **Advanced Text** tab, then tick the **Text Background** box and select the **Properties**... button
beneath it. Then select the Symbol... button and change the fill colour to your preferred choice. Click OK until you return to the layout view.

7.2 Saving a template for future use

If you have created a custom layout you can save it as a template to use with other maps. Select File, Save As... from the menu and save it in your map templates directory. Please refer to your ArcGIS user guide for more details.

To use the template in another project select the Change Layout button from the Layout toolbar. Click the open file button and browse for the template. Click Finish on the wizard and the custom layout will appear.

7.3 Printing a layout

To make a hard copy, click on the Print button or select the File menu, then click Print.... Select a colour printer set on a high resolution for best results.

7.4 Saving a layout for a report

The layout image may also be exported in various image file formats, such as WMF, for use in other applications, such as Microsoft Word. This is generally the recommended option as it results in documents with low memory-usage that print quickly in high quality.
SECTION 8  Georeferencing images

When using raster image map data in ArcGIS the coordinates and scale of the map must be specified before it can be used as a basis for entering source locations. In other words, the map image must be georeferenced. There are several ways to position a map image in ArcGIS. Two of these methods are discussed: using a pre-prepared *.tfw World file, and using the georeferencing toolbar.

8.1 Set map coordinates using a *.tfw World file

Images are stored as raster data, where each cell in the image has a row and column number. Shapefiles are stored in real-world coordinates. In order to display images correctly it is necessary to establish an image-to-world transformation that converts the image coordinates to real-world coordinates. This transformation information is typically stored with the image.

Some image formats, such as ERDAS, IMAGINE, BSQ, BIL, BIP, GeoTIFF, and grids, store the georeferencing information in the header of the image file. ArcGIS uses this information if it is present. However, other image formats store this information in a separate ASCII file. This file is generally referred to as the world file, since it contains the real-world transformation information used by the image. World files can be created with any editor.

World files (*.tfw) for every OS map tile are available to download from the OS website (www.ordnancesurvey.co.uk). To do this, visit the website, select the appropriate product (e.g. 1:50000 Colour Raster) and click on the link to ‘Georeferencing’. Click on the link to download a WinZip file containing all .tfw files for the selected product.

Follow these steps to load and geo-reference your map image:

Step 1  Ensure that your map image file and associated world file are located in the same directory, with the same file name.

Step 2  Click on the File menu and, from the Add Data submenu, select the Add Data... option or click the Add Data button on the toolbar. Figure 8.1 shows the Add Data dialogue that is launched.

Step 3  Locate the data you want to add as a new layer and select the Add button.
Step 4  The image should appear in view in the correct location.

8.2  Set map coordinates using the georeferencing toolbar

Coordinate systems should be set in ArcCatalog, which is displayed by pressing the button. ArcCatalog helps you organise and manage all your GIS information (maps, globes, datasets, models, metadata, services, and so on). It includes tools for processing data and enables you to check that the correct data will be added with the correct format.

Once the ArcCatalog pane is open, locate the map image file you wish to use in the Catalog Tree. An example map tile, SS79R.tif, can be located in the Data folder of the program install directory. Then either double click the file name in the Catalog Tree, or right click the filename and select the Properties... button. You will now see the Raster Dataset Properties screen, as shown in Figure 8.3.
If no coordinate system has been set for this map tile, the Spatial Reference will be `<Undefined>`. To set a coordinate system, select the Edit... button next to the Spatial Reference heading to open the Spatial Reference Properties window, as shown in Figure 8.4. From here, the coordinate system for your map tile can be set to a predefined coordinate system.
system by clicking **Select...**, to an imported coordinate system by clicking **Import...**, or to a new user-defined coordinate system by selecting **New...**. Once the coordinate system has been selected, click **OK** to add it to the **Raster Dataset Properties** page. Click **OK** to close the page.

![Spatial Reference Properties](image)

**Figure 8.4** – The spatial reference properties.
SECTION 8 – Georeferencing images

For example, to set the coordinate system for the map file SS79R.tif, click on the Select... button to select a predefined coordinate system. Select Projected Coordinate Systems, then National Grids, Europe, British National Grid.prj, and then click the Add button, as shown in Figure 8.5. This will return you to the Spatial Reference Properties screen shown in Figure 8.4.

To add the map to the data view, drag and drop the map file name from the Catalog tree to the Table Of Contents.

Once the map has been added, you may need to set the correct distance units in the display. To do this, right click on the Layers Data Frame and select Properties... or select the View menu and click Data Frame Properties.... This opens the data frame properties screen, shown in Figure 8.6. Select the General tab and change the Map Units and Display Units appropriately, e.g. Meters for SS79R.tif, then select OK.
Once the units have been set, you will need to georeference your map tile so that the correct coordinates and scale are set. If you know the correct map coordinates of two reference points on your map tile, then this can be done using the Georeferencing toolbar. To open this toolbar, right click anywhere on the main toolbar then select Georeferencing from the menu. The Georeferencing toolbar will appear, as shown in Figure 8.7.

To set the reference points, select the Add Control Points button. Click the first reference point on your image, e.g. the bottom left corner of the map for SS79R.tif, before clicking any other point on the screen. This will highlight the control point by a red cross, as shown in Figure 8.8. Repeat this procedure for the second reference point, e.g. the top right corner for SS79R.tif.
Now click the View Link Table button to view the selected coordinates and their links, as shown in Figure 8.9. Enter the correct map coordinates for your reference points in the X Map and Y Map boxes. For example, the map coordinates are: (271000,194000) for the bottom left corner, and (276000,199000) for the top right corner. This tells ArcMap to move the point defined by the X and Y Source to the X and Y Map coordinates. Click OK to set the reference points.
The image will now have been set to the correct position. Right click on the map layer and select **Zoom To Layer** to centre the data view on the map. If you move the mouse around over the image and look at the coordinates in the bottom right corner of the screen you will see that they are now shown in the correct OS coordinates. Select the **Georeferencing** drop down menu and select **Update Georeferencing**. This removes the red crosses that were created. If you look in the same folder as the image file you will see that a `.tfw` file has been created to retain the information about the projection.